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Introducing RoundTable

1Introducing RoundTable

RoundTable is the most compelling environment yet for both business collaboration and 
social chatting on the Web. RoundTable combines standard text-based chatting with 
special capabilities that allow you to dynamically share images, documents, URLs, video, 
audio, and more, in a real-time, free-form workspace.

Using RoundTable, you can share images and documents instantly with all the participants 
in a meeting. Imagine being able to instantly pass a file to a colleague on another continent. 
Or think about sharing a real-time, onscreen “canvas” with coworkers around the world, 
where each of you has the ability to type in new concepts, edit one another’s paragraphs for 
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immediate feedback, and automatically save a transcript of the meeting to document both 
the discussion path and the final decisions.

RoundTable also offers an easy-to-use environment for social chatting. Joining a 
RoundTable meeting is as easy as following a link from a Web page. You can join a group 
already in progress, or set up a private meeting and invite group members interested in a 
particular aspect of the discussion.
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What's New in 2.0?

Server Authentication RoundTable 2.0 now supports authenticating servers. Requests for access to these servers 
will pop up a new dialog box requiring the user to enter an appropriate name and 
password.

Read-Only Canvas Administrators can set up read-only canvases to present large amounts of information in 
an attractive, easy-to-access format—while protecting it from unauthorized changes or 
deletions.

Highlighter Tool Need to highlight a particular item on the canvas without obscuring it? A new highlighter 
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tool adds transparent color marking of canvas items. In addition, highlighter markings can 
be changed to pen (opaque) marking, and vice versa.

Easy-To-Save 
Conference Profiles

RoundTable 2.0 lets all users—clients as well as server administrators—easily save a 
RoundTable Conference Profile as a desktop shortcut to their favorite conference sites and 
meetings. These compact .RTC files can be distributed via e-mail, diskette, or Web page link 
for complete portability.

Improved Drawing Tools A new line tool lets you draw freeform shapes on the canvas. In addition, RoundTable’s 
drawing tools now support colors, and text typed directly on the canvas can be in any font 
or point size available on your machine.

Progress Indicators When loading large objects on the canvas, RoundTable 2.0 now displays a progress 
indicator and provides a Cancel option.
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Who Can Use RoundTable?

Business People RoundTable offers business people a convenient medium for long-distance, multiple-site 
work groups. Using RoundTable, coworkers across the country or across the world can:

• Pass files “across the table” in real time. Just drag a file from your Windows Explorer or 
Macintosh Finder onto the RoundTable canvas, and your coworkers can then “pick it 
up” and drag it onto their hard drives. If you have a permanent meeting set up, you can 
leave documents “on the table,” for coworkers to pick up later.

• View a proposed marketing piece, organizational chart, or project timeline onscreen. 
Highlight sections needing changes, or sketch in new ideas.

• Conduct text-based conversations (chat) to discuss important topics with people in 
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many different cities.

Students and Teachers RoundTable allows academics to create virtual classrooms. Using RoundTable, students 
and teachers in different cities can:

• Explore the Internet together, exchanging interesting URLs right on the canvas.
• Share the special knowledge and skills of teachers in one city with students in other 

cities or a rural area.
• Conduct brainstorming and editing sessions in different times and places by leaving a 

piece of work in a permanent meeting and soliciting comments.

Almost Anyone Anyone interested in communicating with other modem users and Net surfers can use 
RoundTable as a meeting place. In the RoundTable conferences, you can:

• Learn more about particular topics in special interest groups where participants 
exchange information and views.

• Network with others in your industry or area of specialization, learning about the latest 
developments across the country.

• Chat with diverse people in other cities and countries, easily talking about almost 
anything!
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Collaborative Conferencing:  What Is It?

Collaborative conferencing allows people in different parts of the city—or different parts 
of the world—to work together on their computers as though they were all seated in the 
same room. But online conferencing makes the process even easier than collaborating in 
the same room. It’s very difficult for a group of people to see the same small computer 
screen; and it’s almost impossible for people viewing a computer screen on an overhead 
projection to all have access to the keyboard for their input. In an online collaborative 
conference, however, everyone has their own computer screen and their own keyboard or 
mouse for making changes. Everyone can get involved, and everyone has “the best seat in 
the house.”
RoundTable 2.0 User’s Manual 1–5

RoundTable’s collaborative conferencing occurs within meetings which may take on a 
variety of forms, depending upon how the administrator sets up the meeting, who 
participates, what their agenda is, etc. But, in general, there are really only three types of 
meetings: public group (many-to-many), private or person-to-person (one-to-one or 
few-to-few), and read-only or one-way (one-to-many).

All three types of meetings involve a conference server which hosts the meeting. This server 
must be set up on a Windows NT machine with special RoundTable server software and 
system requirements. The meeting participants use RoundTable’s client software, which 
can run under Windows 95, Windows NT, or Macintosh, and which has fairly standard 
hardware and software requirements.
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Group Meetings
Status: Public; persistent
Information Flow: Omni-directional (all clients to all clients, routed via server)
Participants: Anyone with RoundTable client software
Activities: Chatting; sketching; sharing of files, URLs, and graphics 
Typical Uses: Group scheduling & decision-making; quick file transfer; document 

review; “chat rooms”; online classrooms; help sessions
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Group meetings are probably the most common type of RoundTable meeting. Conference 
servers typically set up a number of group meetings which remain on the meeting list at all 
times. For example, a computer company site might host Customer Support and Sales 
Information meetings as well as special meetings on topics such as Education, IRC, and 
Collaboration Technology. A corporate server might have meetings set up for each 
department, where employees can easily access their counterparts in other cities. A school 
server could host meetings for different academic departments and individual classes.
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In a group meeting, co-workers, classmates, friends, or families can all participate, more or 
less at once. Similarly, if several people in the same room all speak at once, you cannot hear 
anyone clearly; thus, all are participating “more or less at once.” The same limitations apply 
to a RoundTable meeting, except that RoundTable “holds” the comments onscreen so that 
you can read them all, once after the other. 

Each participant in a group meeting must be running the RoundTable client software and 
connect to a computer running the RoundTable server software. To connect to a 
RoundTable server, you may select a link on a Web page, or you may type a particular IP 
address into your RoundTable Conference Site dialog box. 

Once you connect to a server and join a group meeting, any information you want to 
share—chat, video clips, computer files, graphics—goes from your client machine to the 
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conference server. The conference server places this information on the “canvas” which is 
transmitted back out to each individual client machine so all group members can see, edit, 
or download it to their own machines.
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Private or Person-to-Person Meetings
Status: Private; transient 
Information Flow: Bi-directional (invitees to invitees, routed via server)
Participants: Meeting creator and invitees only
Activities: Private conversations; sharing of confidential documents
Typical Uses: “Break-out” sessions; sensitive file transfers; executive sessions; 

confidential meetings; one-on-one tutorials
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Any RoundTable user (or administrator) can set up a private meeting and invite one or 
more other users to attend. You may wish to set up a private meeting in advance, when you 
have information to share or need to work out a problem “face-to-face” in a collaborative 
environment. Or you may set up the meeting on the fly, when it becomes obvious that the 
larger group meeting is going in one direction, while a few participants would rather 
discuss a specific point separately.
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In any case, even private meetings require one computer to be running RoundTable server 
software. You could have a private meeting between one person running the client software 
and one running the server software; but the more usual scenario involves two computers 
running client software, connecting in a private meeting through another computer 
running the server software.

Although a private meeting usually takes place when all parties are online, that’s not the 
only possibility. For example, if you need to get sketches for the company prospectus 
okayed by colleagues in several states, you can create a private meeting; invite colleagues 
who need to view the sketches, drop the sketches onto the canvas, and leave. Your colleagues 
can visit the meeting when it suits them, review the sketches, and sign off on the project. 
Later that day (or later that week), you return to the meeting, collect the sketches and 
comments, and compile them into final form—all in time for your deadline, and without 
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“hanging around” online to meet with each of your colleagues. Similar meetings could be 
set up for semester team projects, ongoing workgroups, or as an alternative to Internet 
listservs. 

Note, however, that one person must remain connected to the private meeting at all times, 
or the meeting will close down. If you need to leave a meeting open even when there are no 
participants, but you do not want it available to everyone, get your RoundTable server 
administrator to set up a password-protected public meeting for you. That way, it will 
remain on the canvas, but will only be accessible to those persons with passwords.
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Read-Only or One-Way Meetings

Status: Public or private; persistent
Information Flow: Uni-directional (server to client only)
Participants: Anyone with the URL and, if desired, a password
Activities: Information distribution
Typical Uses: Company forms server; class assignments distribution; advertising, 

public relations, and marketing tool
RoundTable 2.0 User’s Manual 1–10

RoundTable 2.0 also allows read-only meeting canvases for disseminating information 
which does not require two-way traffic. A company might use a RoundTable one-way 
broadcast meeting to distribute notices, corporate policies, and forms in a way that is easy 
for all employees to access from any location, at any time. A class might use a broadcast 
meeting to post assignments and copies of class handouts. 
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Only the administrator of the RoundTable conference server can create a broadcast 
meeting; and only the administrator can add, move, or delete items from the meeting 
canvas. The clients can view the read-only canvas and make copies of files and URLs to their 
local machines. They cannot, however, move or delete any items, so that the read-only 
meeting canvas always remains pristine, with all items available to users.
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Customer Support

The first line of support should be this manual and the online Help or Guide file.

Windows 95/NT Throughout this manual, information that pertains only to Windows systems is marked by 
a graphic like the one to the left of this paragraph. 

Additional assistance is available through a standard Windows Help file. To access the Help 
file from within the RoundTable client, go to the Help menu and select Contents. You can 
also open the RoundTable Help file on its own by locating the RoundTable folder and 
double-clicking the file ending in .HLP.
RoundTable 2.0 User’s Manual 1–12

Macintosh Information in this manual that pertains only to Macintosh systems is marked by a graphic 
like the one to the left of this paragraph.

Additional assistance is available through a standard Macintosh Guide file. Note that you 
must have Apple Guide installed on your system to use this file. To access the Guide file 
from within the RoundTable client, go to the Guide menu and choose RoundTable Guide. 
You can only access the file from within the RoundTable client; the Macintosh Guide 
system does not allow standalone files.

Visit Our Web Site If you cannot find the information you need in either of these sources, contact us at our 
Web site. All of the on-line help options are detailed on our Customer Support home page 
http://www.ffg.com/support.html .

http://www.ffg.com/support.html
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2 RoundTable’s installation program makes the process of setting up your client software 
quick and easy. To be certain that everything works optimally, make sure that your system 
meets the minimum requirements.

Shut Down 
Other Programs

It is always best to install a program with no other programs running in the background.

• If you are running under Windows 95 or Windows NT, use Alt-Tab to switch to each 
running program in turn and then exit that program.

• If you are running on a Macintosh machine, use the Application menu (in the upper 
right corner of the screen) to switch to each running program in turn and then exit that 
program.

Distinguishing Between This chapter contains the necessary information for running the RoundTable client 
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Macintosh and 
Windows Instructions

software on both Windows and Macintosh machines. In most cases, the instructions are 
identical on both platforms. However, in some cases there are differences. To help you 
quickly locate the appropriate instructions for your system, we have used the following 
visual clues:

Indicates information pertinent only to Windows systems.

Indicates information pertinent only to Macintosh systems.

If you see both graphics together or if there are no icons in that section, 
the information is substantially the same for both Windows and 
Macintosh systems.

The paper clip graphic calls your attention to a special note or tip that will make your 
RoundTable use easier or more productive.
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Installation Overview

Once your RoundTable client software is set up, it’s easy to log in and join a meeting. But 
because RoundTable integrates your desktop machine with a conference server and the 
Internet, it does require just a bit more than copying files.

To set up RoundTable client, you will:

• Install the client software on a Windows or Macintosh machine. see Installing the Client 
under Windows 95/NT or Installing the Client on a Macintosh.

• Integrate the client software with your Web browser. See Configuring Your Web Browser 
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on a Macintosh.

Related Pages:
Installing the Client under Windows 95/NT, pg. 2–6
Installing the Client on a Macintosh, pg. 2–13
Configuring Your Web Browser on a Macintosh, pg. 2–14
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Upgrading from Version 1.0

RoundTable 2.0 presents a significant upgrade from previous versions, with increased 
functionality and enhanced speed. While version 1.0 users should find the interface looks 
familiar enough to be comfortable, they will discover many new features are now available. 
However, these enhancements required a substantially different approach to the “hidden” 
parts of the program, so that, in many ways, RoundTable 2.0 is not backwards compatible 
with RoundTable 1.0.

Dealing with 
Server/Client 
Incompatibilities

You can not access a RoundTable Conference Site on a 1.0 server site with the RoundTable 
2.0 client; nor can you access a RoundTable Conference Site on a 2.0 server site with the 
RoundTable 2.0 User’s Manual 2–3

RoundTable 1.0 client. 

Due to these incompatibilities, we suggest that you do not install the version 2.0 software 
over the 1.0 software. If you want to install the new version over the old version, you must 
be sure that you will be accessing and accessed by only 2.0 Conference Sites (as in the case 
of strictly intranet or inter-company sites). 

Maintaining Old 
Preferences

If you have been using a previous version of RoundTable, your preferences will be 
maintained. This includes such items as voices, colors, and your Personal Info. 
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Integrating the Client with Your Web Browser

The RoundTable client integrates with your Web browser in three different ways:

• A meeting participant can grab URLs from a Web 
browser and place them on the canvas. Other 
participants can then double-click the URL to display it 
in their own Web browser.

• A user can select a meeting from a list on a Web page. 
Clicking on a particular meeting from the list launches the 
RoundTable client software, connects to the conference server 
hosting the meeting, and opens the meeting canvas.
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• A user can join a meeting by double-clicking on an .RTC file 
which launches RoundTable, connects to the conference server, and joins the meeting. 

The first type of integration requires only that the RoundTable client’s General Preferences 
be set to recognize the Web browser on your system. This feature has been tested and found 
to work with the release (non-beta) versions of Microsoft Internet Explorer and Netscape 
Navigator. It is likely to work with many other Web browsers as well.

The second type of integration requires the conference administrator to set up a gateway. 
It also requires that client users set up RoundTable as a helper application with their Web 
browser. 

The third form of integration requires that the operating system associate the RTC file type 
with RoundTable. This is done automatically in the general installation procedure.

This section discusses how to set the two most popular Web browsers—Microsoft Internet 
Explorer and Netscape Navigator—to integrate with RoundTable. For information on 
setting up other browsers, contact the browser manufacturer or your system administrator.

Related Pages:
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Windows 95/NT System Requirements
To run the RoundTable 2.0 client on a Windows machine, your system must include at least 
the following:

Item Requirement

Processor/
Operating System

486-SX or higher class machine running 
Windows 95™ or 
Windows NT Workstation 4.0™

RAM 4 MB 
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Recommended System For best results, we recommend the following enhanced configuration:
• 486DX-33 or higher class machine
• 8 MB RAM
• 4 MB free hard drive space
• At least a 28.8 Kb modem connection to the RoundTable server

Free Hard Drive Space 2 MB

Connection Hardware 14.4 Kb modem with a Winsock-compliant net-
work software product

Internet Connection A direct TCP/IP connection to the RoundTable 
server, through the Internet or an Intranet, and 
unobstructed by a firewall or proxy server

Web Browser Production version (no betas) of:

• Internet Explorer™ version 2.0 or higher
• Netscape Navigator™ version 2.0 or later
• Enhanced Mosaic™ version 2.0 or later
• or other SpyGlass SDI standard-compliant 

Web browser
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Installing the Client under Windows 95/NT

Use this procedure to install your RoundTable client on a Windows machine.

Installing the Program Step Procedure

1. If you are installing RoundTable from an installation disk or CD-ROM, insert 
disk 1 or the CD in your floppy or CD drive. 

OR

If you have downloaded RoundTable as a .ZIP  file, copy your zip file (*.ZIP ) into 
an empty folder (or directory). Double-click on the.ZIP  file or open it into the 
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current empty folder from within your zip manager. (If you are using a zip manager, 
you may have to follow a few extra steps to unzip the file. Consult the zip manager 
documentation for details.) All program files will be expanded into the current 
folder (or directory). 

OR

If you have downloaded RoundTable as an .EXE file, copy your EXE file into an 
empty folder (or directory). Double-click on the .EXE  file. A dialog box appears, 
informing you that this will install ForeFront RoundTable and asking if you wish to 
continue. Click on Yes to continue the installation procedure and start the 
InstallShield Wizard. Skip Step 2 and go directly to Step 3.
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2. Click on your Windows Start button, choose Settings, and then Control Panel. The 
system displays the Control Panel. Double-click on Add/Remove Programs. 

When the system displays the Add/Remove Programs dialog with the Install/Uninstall 
tab showing, click Install. In the next screen (titled Install Program From Floppy Disk or 
CD-ROM), click Next to let Windows 95 find the setup file. If Windows cannot find 
the SETUP.EXE file, use the Browse button to navigate to the folder into which you 
copied and expanded your RoundTable files.

When A:\SETUP.EXE  (or SETUP.EXE preceded by the appropriate path) appears 
in the Command line for installation program text box, click Finish to start the Install 
Shield Wizard.
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3. The Install Shield Wizard loads. When the Welcome screen appears, you are advised 
to close down all currently running programs. Use A-T to switch to each running 
program in turn and then exit that program. Click Next to continue the installation 
process.

4. On the User Information screen, type in your name and the name of your company. 
You must type in a company name. Click Next to continue.

5. On the Setup Type screen, you have the option of choosing whether you want to 
install the Typical, Compact, or a Custom set of files. If you choose Custom, choose 
which parts of the RoundTable server to install from the Select Components dialog. 
Click Next.

In addition, you may choose the directory in which to install RoundTable. By 
default, RoundTable installs on your hard drive in C:\PROGRAM 

FILES\FOREFRONT\ROUNDTABLE, where c:\ is the name of your hard drive. If 
you want to use the default location, select Next. 
Otherwise, use Browse to select the location you want to use for RoundTable, then 
select Next.
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6. On the Select Program Folder screen, you have the option of choosing the Program 
Folder in which RoundTable will appear on your Start menu. By default, 
RoundTable appears in its own folder. To add it to an existing folder, click on one of 
those displayed in the bottom scroll window. To put RoundTable in a new folder, 
type the desired name in the type text field (where ForeFront RoundTable appears 
by default). Click Next to continue.

7. Review the setup information. If it is correct, click Next to start copying files. If you 
need to make changes, click Back to make the changes, and then click Next until the 
program starts copying files.

8. The Setup program copies and installs all necessary files to your hard drive.
RoundTable 2.0 User’s Manual 2–8

9. At the end of the installation process, the Installation Shield Wizard opens the 
folder in which you installed RoundTable. To run the program, double click on the 
application icon. RoundTable loads and displays the Welcome screen.

10. If you have never previously registered RoundTable (for example, an earlier 
version), RoundTable then switches to your Web browser and displays the 
ForeFront Registration page on the Web. If your Web browser is not running or you 
do not have a suitable Internet Web site, you may return to the registration process 
later.

11. Complete the Registration page, then select submit. All fields followed by an asterisk 
(*) must be completed. If you want to change your registration at any later time, 
select Registration from the Help menu.

Next Step After installing the RoundTable client and associating the .RTC extension with the 
program, be sure to configure your Web browser to use RoundTable as a helper application. 
See Configuring Your Web Browser under Windows.
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Configuring Your Web Browser under Windows

The procedures below explain how to configure the two most popular Web browsers—
Microsoft Internet Explorer and Netscape Navigator—to use your RoundTable client as a 
helper application. If you are using another Web browser, the procedure should be similar. 
Contact your system administrator or browser manual for details.

Configuring 
Netscape Navigator Step Procedure

1. From Navigator’s Options menu:

• If you are using Navigator 2, choose the Preferences command. 
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• If you are using Navigator 3, choose the General Preferences command.

2. In the Preferences dialog:

• If you are using Navigator 2, choose the Helper Applications tab.

• If you are using Navigator 3, choose the Helpers tab.

3. Click the Create New Type button to set up a new mime type. Set up the following:
• MIME type: application
• Subtype: x-ffgrtconf 
• Extension: rtc
• Action: Launch the Application

4. You may have to restart Navigator for your changes to take effect.

Carryover for Microsoft
Internet Explorer

Normally, you do not need to configure Microsoft Internet Explorer because it is closely 
integrated into the Windows system, that the general installation procedure which 
associates RTC files with RoundTable carries over to set up RoundTable as a Helper 
Application in Internet Explorer. We provide the manual process here in case you should 
encounter a problem. Note that these instructions do NOT work if RoundTable is already 
set up as a Helper Application for Internet Explorer.
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Configuring Microsoft
Internet Explorer Step Procedure

1. From Internet Explorer’s View menu, choose Options.

2. In the Options dialog:

• If you are using Internet Explorer 2, choose the File Types tab.

• If you are using Internet Explorer 3, choose the Programs tab and then click the 
File Types button (in the Viewers section)

3. In the list of Registered file types, look for .rtc.

• If you find .rtc, select it and click Edit.

• If you do not find .rtc, click New Type.
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4. In the resulting Edit or New Type dialog, set up the following:

• Description of Type: RT Profile

• Associated Extension (in New Type only): .rtc

• Content Type (MIME): application/x-ffgrtconf

• Default Extension for Content Type: .rtc

5. If the Actions window of the Edit or New Type dialog lists Open:
• Select open and click the Edit button
• Use the Browse button to locate your RoundTable file: RoundTable.exe

If you do not find open in the Actions window:
• Click the New button below the Actions window. 
• In the New Action dialog, type open in the New Action text field, use the Browse 

button to locate your RoundTable file (RoundTable.exe). Click Open, then 
OK to return to the Edit or New Type dialog.

6. Click Close and OK as required to return to the main Internet Explorer window.

7. You may have to restart Internet Explorer for the change to take effect.

Next Step After you install your RoundTable client and integrate it with your Web browser, go join a 
meeting! See Chapter 3, Attending RoundTable Meetings.
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Macintosh System Requirements

To run the RoundTable client on a Macintosh, you must have at least the following setup:

Item Requirement

Processor/
Operating System

68020 or higher class machine 
(includes all Power PC® and Quadra® models)
running System 7.1 or higher

RAM 4 MB available to RoundTable
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Related Pages:
Configuring Your Web Browser on a Macintosh, pg. 2–14

Free Hard Drive Space 4 MB

Connection Hardware 14.4 Kbmodem connection to RoundTable 
server using Open Transport ™1.1 or higher or 
MacTCP® 2.0.5 or higher

Internet Connection A direct TCP/IP connection to the RoundTable 
server, through the Internet or an Intranet, and 
unobstructed by a firewall or proxy server

Web Browser Production version (no betas) of:

• Internet Explorer™ version 2.0 or higher
• Netscape Navigator™ version 2.0 or later
• Enhanced Mosaic™ version 2.0 or later
• other SpyGlass SDI-compliant browser
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Recommended System For best results, we recommend the following enhanced configuration:
• 68040 or higher class machine
• 8 MB RAM available to RoundTable
• System 7.5
• at least a 28.8 Kb modem connection to the RoundTable server
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Installing the Client on a Macintosh

Installing the Program Step Procedure

1. If you are working from an installation disk or CD, insert disk 1 or the CD in the 
appropriate drive. Double-click RoundTable Installer.

If you have downloaded RoundTable as an .HQX file, convert the file by dragging it 
onto your StuffIt Expander™ or similar utility. Double-click the converted .SEA 

file to start the RoundTable Installer.

2. When the RoundTable splash screen appears, click Continue to load the License 
Agreement. Read it and click Continue to signify your agreement.
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3. On the next screen choose your operating system and how much of the program to 
load. Installing for a pre-System 7.5 O/S will install the Apple Drag and Drop 
extensions. Choose the correct option, then click Install.

4. In the dialog box that appears, navigate to select the folder in which you want to 
install RoundTable. Click Install.

5. The Setup program copies all necessary files to your hard drive and creates a folder 
containing RoundTable and related files.

6. When RoundTable notifies you that installation is complete, choose Quit. On a 
pre-System 7.5 system, you may have to restart your machine.

7. If you plan to use Conference Profiles, locate and double-click on a Conference 
Profile in the Finder. If RoundTable does not open automatically, you should get a 
dialog asking you to specify the application. Choose RoundTable and, if desired, 
check the option to always use this combination.

Next Step After installing the client, configure your Web browser to use RoundTable as a helper 
application. See Configuring Your Web Browser on a Macintosh.

Related Pages:
Configuring Your Web Browser on a Macintosh, pg. 2–14
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Configuring Your Web Browser on a Macintosh

The procedures below explain how to configure the two most popular Web browsers—
Microsoft Internet Explorer and Netscape Navigator—to use your RoundTable client as a 
helper application. If you are using another Web browser, the procedure should be similar. 
Contact your system administrator or browser manual for details.

Configuring 
Netscape Navigator Step Procedure

1. From the Options menu choose General Preferences , then the Helpers tab.

2. Look in the list of helpers for a RoundTable listing
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• If you find the listing, click Edit to verify the settings with those in the next step.
• If you do not find it, click the New button to set up a new mime type. 

3. Set up or edit the entries to match the following.

If you are using Navigator 3.0:
• Description: RoundTable Conference
• MIME type: application/x-ffgrtconf
• Suffixes: blank
• Handled by: / Application: RoundTable
• File type: TEXT

If you are using Navigator 2.0:
• MIME type: application
• Subtype: x-ffgrtconf 
• Extension: blank
• Application: RoundTable
• File type: TEXT
• Action: Launch Application

4. Click OK as required to close the dialog and return to the main Navigator window. 
You may have to restart Navigator for your changes to take effect.
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Configuring Microsoft
Internet Explorer Step Procedure

1. Go to the Edit menu and choose Options.

2. In the Options dialog, choose the Helpers tab.

3. In the list, look for RoundTable or RTC Files.

• If you find an entry, select it and click Edit.

• If you do not find an entry, click Add.

4. In the top portion of the resulting dialog, set up or edit the entries to match the 
following.

• Description: RoundTable
• MIME type: application/x-ffgrtconf
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• Suffixes: blank
• Encoding: TEXT

5. In the Handling section of the dialog:

• Click on the Choose button and locate your copy of RoundTable, then click 
Select to return to the previous dialog box. 

• Verify that the How to Handle drop-down list displays the choice: Use a Helper 
Application

• Type TEXT in the File Type text box

6. Click New and then OK as required to return to the main Internet Explorer window.

7. You may have to restart Internet Explorer for the change to take effect.

Next Step After you install your RoundTable client and integrate it with your Web browser, go join a 
meeting! See Chapter 5, Attending RoundTable Meetings.
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Uninstalling the Client under Windows 95/NT

Use the standard Windows Add/Remove Programs utility to uninstall RoundTable.

Using Windows 95 Step Procedure
Add/Remove Programs

1. Click on the Windows Start button.
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2. Select Settings and then Control Panel.

3. Double-click on the Add/Remove Programs icon.

4. Click on RoundTable where it appears on the list in the bottom part of the window. 

5. Click on the Add/Remove command button. The system displays the Confirm File 
Deletion dialog.

6. If you really want to remove the program, click on Yes when the system asks: Are 
you sure you want to completely remove the selected application and all its components?

7. Answer Yes when the system asks about removing shared files. 

8. When the Uninstall Shield indicates that program removal is complete, click OK to 
close the dialog box.
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Conference Profiles Neither the included uninstall program nor the Windows Add/Remove Programs utility 
deletes Conference Profiles you have saved in other folders. If you want to remove all 
Conference Profiles from your hard drive, you must delete the files manually.

Deleting Your
Conference Profiles Step Procedure

1. Open the Windows Explorer.™ (On a standard Windows 95 installation, you can 
get to Explorer by clicking on the Windows Start button and choosing 
Programs/Windows Explorer.)

2. Navigate to folder where you have stored your RoundTable Conference Profiles.

3. Delete the files ending in .RTC.
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4. Close Explorer.
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Uninstalling the Client on a Macintosh

The RoundTable client is easily removed from your system.

Uninstalling Step Procedure
RoundTable

1. Open your hard drive or the network drive on which you have installed 
RoundTable.
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2. If you really want to remove the program, drag the RoundTable folder containing 
the executables and database files to the Trash.

3. Navigate to your System Folder, and then the Preferences folder within it. Locate the 
RoundTable ƒ folder and drag it to the Trash.

4. If you have saved Conference Profiles on your Desktop or in other folders on your 
hard drive, you must delete the files separately. 

In your Finder, navigate to the location where you have stored your RoundTable 
Conference Profiles.

Delete the Conference Profiles (files ending in.RTC).
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3 As a meeting participant, you will use the RoundTable client software—a “client” program 
that runs on your Windows or Macintosh desktop machine and connects to other clients 
through another machine running the RoundTable Conference “server” software. A server 
can host one or more meetings, “serving up” images and other information to all the clients 
who connect to its meetings. The server and clients connect together across the Internet; 
physically, they may be located anywhere in the world.

Attending a RoundTable meeting is just like attending a “real meeting,” except that all the 
participants need not be in the same physical location. Some features—such as joining and 
leaving—are common to all meetings. Others—such as sketching on the canvas or sharing 
URLs—occur only at some meetings. The diagram on the next page outlines common 
RoundTable activities. The rest of this chapter tells you how to perform those tasks.
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Distinguishing Between 
Macintosh and 
Windows Instructions

This chapter contains the necessary information for running the RoundTable client 
software on both Windows and Macintosh machines. In most cases, the instructions are 
identical on both platforms. However, in some cases there are differences. To help you 
locate the appropriate instructions for your system, we have used the following visual clues:

Indicates information pertinent only to Windows systems.

Indicates information pertinent only to Macintosh systems.

If you see both graphics together or if there are no icons in that section, 
the information is substantially the same for both Windows and Macintosh systems.

The paper clip graphic calls your attention to a special note or tip that will make your 
RoundTable use easier or more productive.
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Attending Meetings—Overview
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Understanding RoundTable Terminology

Before you continue, you should understand a few terms.

Conference Server A computer running the RoundTable server software that allows the conference 
administrator to set up various meetings allowing people from all over the world to chat 
and share information together. As a client, you must connect to a conference server 
(through a Web page link or your RoundTable client software) before you can join one of 
its meetings.

Conference Site The location of the computer running the RoundTable server software. From the client 
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side, the location of the conference is identified just like the location of any other Web page. 
For example, a home page is often located at http://www.companyname.com.  Their 
conference site might then be located at 
http://www.companyname.com/rt/http2conf.

Client The RoundTable software application that allows an end user (or meeting participant) to 
connect to a Conference Server, join a meeting, and interact with other users around the 
world who are connected to the same Conference Server.
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Setting Up Your Personal Information

Before you enter a RoundTable meeting, you may want to set up your personal 
information; that is, the information that other meeting participants will have about you. 
Then you can select your meeting and join in.

This section will detail the procedure for setting up your own personal information. For 
information about choosing your meeting, see Choosing and Joining a Meeting.

Setting Up Your 
Personal Information Step Procedure
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Related Pages:
Choosing and Joining a Meeting, pg. 3–9

1. If RoundTable is not already running, launch it and click the Cancel button on the 
splash screen.

2. Go to the Options menu and choose Setup Personal Info...

3. Enter as much information in the text fields as you wish to share with the other 
meeting participants.

• Press Tab to go to the next text field.

• Press Shift-Tab to return to the previous text field.

4. Use the radio buttons to specify your gender, if desired.

5. When you finish entering information, click OK to close the dialog.
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Getting Connected

You can connect to a RoundTable Conference Server in a number of ways. If you generally 
connect to one of a small list of conference sites, you will probably connect directly from 
the RoundTable client through the Connect button on the client’s opening screen. However, 
you can also connect directly from a link on a Web page (if the Conference Server has set 
one up), or you can use a Conference Profile. Once you have connected to a Conference 
Server and joined a meeting, you can begin chatting with people from all over the world, 
or you can use the freeform canvas workspace to share information with other meeting 
participants by dragging images, text, files, or URLs onto the canvas.
RoundTable 2.0 User’s Manual 3–5

Connecting from the 
RoundTable client 

Use this procedure to join meetings at the ForeFront Conference Site, or to connect to any 
Conference Server where you know the IP address and port number or someone else has 
set it up for you. 

Step Procedure

1. Launch the RoundTable client software:

In Windows, choose it from your Windows Start menu 
(Programs/ForeFront/RoundTable, if you have used the default settings) or double-click 
the RoundTable.exe  file in Windows Explorer or File Manager (C:\Program 

Files\ ForeFront\ RoundTable\ RoundTable.exe , if you have used the 
default settings).

On a Macintosh, double-click the RoundTable icon in the RoundTable folder, or 
choose RoundTable from the Applications section of your Apple menu (if you have 
added RoundTable to the list).

2. On RoundTable’s Welcome screen, click the Connect button to display the Connect 
Conference Site dialog.
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3. In the Connect Conference Site dialog, choose or setup the desired site:

To visit a site already listed, choose the Conference Site name from the drop-down 
Site list.

To set up a new site, click the Setup button, then the Add button in the Conference 
Sites dialog. In the dialog, type the desired name for the site as its Label, the IP 
address of the machine hosting the RoundTable server as its Hostname, and the 
correct Port used by the machine hosting the RoundTable server in the appropriate 
text boxes. Click OK; click on the site to highlight it in the Conference Sites dialog 
list; and click OK again.

To modify and then connect to a currently listed site, click the Setup button, then 
the Modify button in the Conference Sites dialog. In the dialog, change any of the 
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settings as necessary and click OK. To connect to the modified site, select it in the 
Conference Sites dialog list and click OK again.

4. Back in the Connect Conference Site dialog, type the Nickname you wish to use in 
the meeting. 

5. Click Connect to join the meeting.

Connecting from 
a Web Page Link

Use this procedure if you wish to join a meeting that appears as a hot link or button on a 
Web page.

Step Procedure

1. Make sure your Web browser is configured to use RoundTable as a helper 
application. For more information, see Configuring Your Web Browser on a 
Macintosh or Configuring Your Web Browser under Windows. You may have to 
restart your Web browser for the changes to take effect.

Related Pages:
Configuring Your Web Browser on a Macintosh, pg. 2–14
Configuring Your Web Browser under Windows, pg. 2–9
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2. Use your Web browser to navigate to the site with the Web page link. For example, 
visit ForeFront’s Conference site through the link at http://www.ffg.com.

3. Locate a link to a conference site you wish to visit or a meeting you wish to join. 
Click on the link. 

4. Your Web browser launches RoundTable and asks for your nickname. If the link is 
to a conference site, look through the meetings and join one. If the link is directly 
to a meeting, RoundTable automatically joins the meeting, prompting you for a 
password, if necessary.

Connecting from 
a Conference Profile

Use this procedure if someone has sent you a Conference Profile or if you have previously 
created one. For information on creating Conference Profiles, see Saving and Sharing 
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Conference Profiles.

Related Pages:
Saving and Sharing Conference Profiles, pg. 4–19

Step Procedure

1. Locate the desired Conference Profile on your computer. 

• If someone has e-mailed you a Profile, find the name or link in the email message.

• If you have saved the Profile on your hard drive, use the Windows Explorer or 
Macintosh Finder to locate the file.

• If you have created the Profile yourself (or moved it since you received it), you may 
be able to find it as a shortcut on your Windows desktop or as an alias on a 
Macintosh.
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2. Double-click the Conference Profile icon or file name.

TIP: Microsoft Exchange and some other e-mail programs automatically turn 
filenames in messages into clickable links. If your e-mail program does not do this, 
you may need to export the link or save it to another file. See your e-mail program 
manual or online Help for instructions.

3. Your system automatically launches RoundTable. 

If you have not saved your nickname as part of the profile, a dialog box appears 
asking for your nickname. Type the nickname you want to use into the blank text 
field and click OK. RoundTable then launches.
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4. If the Profile links to a conference site, you can look through the meetings and join 
one. If the Profile links directly to a meeting, RoundTable joins the meeting, 
prompting you for a password, if necessary.
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Choosing and Joining a Meeting

When you connect to a RoundTable meeting from a Web page link or a configuration file, 
you will probably connect directly to a specific meeting. But if you use the RoundTable 
client to connect to a conference site, you must choose the meeting you wish to attend. Use 
the procedure below to review the meetings in session at the conference site. In addition, 
you can examine a list of all conference participants and inspect their personal information 
to determine who you wish to meet with.

Meeting List The Meeting List Window displays a a list of all meetings at the site 
and the number of participants attending each meeting. You can join 
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any meeting by double-clicking on the meeting name.

Conference Roster The Conference Roster Window contains a list of everyone currently 
connected to the conference site. You can view the Personal 
Information for any meeting participant by double-clicking their 
name in the Conference Roster.

Joining through 
the Meeting List Step Procedure

1. If RoundTable is not running, launch it, click the Connect button and choose your 
Conference Site to display the Meeting List window.

If RoundTable is running but the Meeting List is not displayed, go to the View 
menu and select Meeting List to display the Meeting List window.

2. The Meeting List window shows all meetings currently in session, together with the 
number of participants attending each meeting.



Attending RoundTable Meetings

3. If you wish to get information about those currently connected to the site, check 
the Conference Roster. If it is not currently displayed, go to the View menu and 
select Conference Roster to display this list of conference participants.

Examine the Conference Roster window. To get 
information about a participant, click once to focus on 
the desired participant. Then go to the Participants 
menu.
OR
If you are running the RoundTable client on a Windows 
machine, right-click the participant’s name to display a 
shortcut menu.
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4. From either the Participants menu or the Shortcut menu:

• Choose List Meetings to list all the meetings that participant has joined.

• Choose Information to display the Personal Information the participant has 
submitted.

5. Examine the Meeting List and/or Personal Information windows. 

TIP: If you wish to keep a copy of a participant’s personal information, click the 
Save button, then specify a folder and filename in which to save the information.

Click OK to close the windows when you are finished.

6. Use the information you gather to decide what meeting you want to join. In the 
Meeting List window, double-click the name of the meeting you wish to join. 

7. RoundTable connects you to the meeting and loads the meeting canvas. If the 
meeting canvas is slow to load, you may wish to load images as icons only. To 
avoid AutoLoading images, go to the Options menu, choose the Preferences 
command, and then the General tab. Clear the check box before Images under Auto 
Load.
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Understanding the Meeting Display

When you join a meeting, RoundTable loads the meeting’s Participant List, Chat Panel, and 
Meeting Canvas, which displays any files, URLs, or other objects that meeting participants 
have placed there. The illustration below shows the client program under Windows . The 
Macintosh client is similar. Once you join a meeting, you can gather information about the 
meeting and its participants, “listen” to the chat, or join right in. See Getting Information 
on a Meeting, Conference Roster, and Talking to Other Meeting Participants.

Meeting Canvas
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Related Pages:
Conference Roster, pg. 3–9
Getting Information on a Meeting, pg. 3–12
Talking to Other Meeting Participants, pg. 3–13

AutoLoading Images If you have limited bandwidth connection (for example, a 14.4 baud modem) or if you join 
a meeting with a great number of images, you may prefer to load images only as icons.

• To turn off the AutoLoad option, go to the Options menu, choose Preferences, and then 
the General tab. Clear the check box before Images under Auto Load.

• When you do want to see the images, go to the Canvas menu and choose Load Images, or 
turn the Auto Load preference back on.

Chat
Panel

Participant
List

Type your
text here.
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Getting Information on a Meeting

Each meeting has a Meeting Info dialog which gives details about its configuration and 
participants. You can view this information only after you join the meeting.

Viewing 
Meeting Properties Step Procedure

1. Join the desired meeting. For details, see Choosing and Joining a Meeting.

2. In the Meeting List window (not in the meeting itself), select the desired meeting. 
Then go to the Meeting menu and select Properties. On a Windows system, you can 
also right-click the desired meeting and select Properties from the shortcut menu.
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3. RoundTable displays the Meeting Properties dialog with the Configuration page on 
top. Unless you have administrator privileges, all choices will be grayed out, 
indicating you cannot make changes.

Related Pages:
Choosing and Joining a Meeting, pg. 3–9

4. Click on Participants to view the number and names of meeting participants.

5. When you finish reviewing all information, click OK to close the dialog.
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Talking to Other Meeting Participants

Just like face-to-face meetings, RoundTable meetings most often focus on conversations 
among the participants. In a RoundTable meeting, you can listen to the conversation, talk 
(or chat) with all the participants, whisper to only a few meeting members, make gesture 
(actions) to reinforce your communication, and even ignore certain participants.

Chatting in a Meeting Step Procedure

1. Look at the Participant List to see who is attending the meeting and at the Chat Panel 
to see what they’re saying in the current conversation.

2. When you want to join in the conversation, click in the blank text field below the 
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Chat Panel and type in your chat text.

3. If you want all meeting participants to see and hear your chat text, press Enter (in 
Windows) or Return (on a Macintosh). You can also click Send.

Whispering Text 4. Whisper if you want only certain meeting participants to see your chat text.

• Type your text in the blank text field below the Chat Panel.

• In the Participant List, select the nicknames of the participants to whom you 
want to send the message. Use Ctrl-Click (in Windows) or Shift-Click (on the 
Macintosh) to select multiple nicknames. 

• When you have selected all desired nicknames, click Whisper to send your text.

Sending a Direct 
Message

5. Send a Direct Message if you want only one participant to see your chat text.

• In the Participant List, select the nickname of the desired participant.

• Go to the Participant menu and choose Direct Message.

• In the dialog that appears, type your message in the upper Message: window, 
then click OK to send it..
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Sending Actions 6. To make a gesture, type the description of the action in the blank text field below 
the Chat Panel, then click Action. On a Macintosh system, you can send actions you 
have set up in advance by clicking the Action button and choosing the desired 
action from the list. RoundTable displays the text with the actor’s name and an 
action marker. For example, to let the other people know you found someone's 
remarks humorous, you can type “is rolling on the floor laughing!” and click 
Action. RoundTable displays the following in the Chat Panel: 
“** Donald is rolling on the floor laughing!”

Choosing Colors 7. To help you keep track of who says what, you can choose the colors used to display 
chat text entered by yourself and other participants. To specify the text chat color 
for just one participant (yourself or someone else):

• On the Participant List, choose the desired participant.
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• Go to the Participant menu and select Colors...
• In Windows, select a color from the Basic Colors displayed or define a custom 

color. Click OK to apply the selection and to close the dialog.
On a Macintosh, select a color from the flyout menu that appears.

To select colors for yourself, the meeting announcer, and other participants at once:

• Go to the Options menu and choose Preferences, then the Colors tab.
• Use the Choose Color buttons to access the Basic Colors dialog and select colors 

for Me (yourself), the Announcer, and any New Participant who joins. The Random 
selection lets RoundTable choose the colors for new participants. Click OK to 
close the Color after each choice. 

• In the Preferences dialog, click Apply to activate your choices without leaving the 
dialog, or OK to activate your choices and close the dialog.

Choosing Voices 8. If you are using a sound board (on a Windows machine) or have installed PlainTalk 
(on a Macintosh), you can hear the text in one of RoundTable’s voices. To select 
voices for a single participant:

• Click on the participant’s name in the list of meeting Participants.
• Go to the Participant menu, choose Voices, then select a voice from the list. 



Attending RoundTable Meetings

To select voices for yourself, the meeting announcer, and other participants at once:

• Go to the Options menu and choose Preferences, then the Voices tab.
• Use the drop-down list boxes to select voices for Me (yourself), the Announcer, 

and any New Participant who joins the meeting.
• Click Apply to activate your new choices without leaving the dialog.

Click OK to activate your choices and close the dialog box.

Ignoring Participants 9. As the meeting progresses, you may wish to ignore a participant’s contributions. 
Select the desired nickname from the Participant List, go to the Participant menu 
and choose Ignore. You will no longer see or hear that participant’s contributions.
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Drawing on the Canvas

When you join a meeting and click on the canvas, RoundTable activates the tools you need 
for drawing and typing on the meeting canvas. Most of the tools should be familiar to you 
from other word processors and graphics programs. You can use these tools in various 
combinations to meet your needs in any given meeting.

Displaying the Tools RoundTable makes the canvas tools available only when you have joined a meeting and 
clicked on the canvas (not in the Chat Panel). Once you click on the canvas, however, you 
can hide or display the various tools by going to the View menu and using the commands 
matching the labels below. Note that the Macintosh client divides the tools into two groups, 
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while the Windows client divides the tools into four groups.

Toolbar Font Bar

Draw
Tools

Color
Bar

Draw
Tools

Toolbar
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Sketching on the Canvas Step Procedure

1. Connect to a Conference Site and join a meeting, then click on the meeting canvas 
approximately where you want to begin sketching.

2. If you want to draw a line, curve, or simple shape, or if you want to highlight an 
item placed on the canvas, choose the appropriate item from the Draw Tools.

• Use the Color Bar to change the color of any drawing tool.

• Use the Line Width box to choose the desired width and style of pen—straight or 
calligraphic. (This box appears only when you choose one of the line tools or 
open shape tools.)

• (Windows only) Use the Pen/Highlighter tools to change the your drawing from 
opaque to transparent.
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3. Draw on the canvas as desired.

4. To reposition one of your drawing objects, use the Selection Tool.

5. To change tools, click on the desired tool and choose the appropriate options.

6. When you are finished sketching, click in the Chat Panel to return to your 
conversations or proceed to use any of RoundTable’s other meeting options.

Straight Line, Freeform Line
Open Box, Filled Box

Open Oval, Filled Oval

Straight Line Widths

Calligraphic Pens

Pen, Highlighter

Selection Tool
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Sharing Text at the Meeting

In addition to typing information into the Chat Panel to share with other meeting 
participants, you may want to type directly on the Meeting Canvas. RoundTable’s text tool 
lets you do this, in any color or font on your system.

Displaying the Tools RoundTable makes the canvas tools available only when you have joined a meeting and 
clicked on the canvas (not in the Chat Panel).

Selection
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Typing on the Canvas Step Procedure

1. Connect to a Conference Site and join a meeting, then click on the meeting canvas 
approximately where you want to begin typing.

2. Choose the Text Tool.

• Use the Color Bar to change the color of your text, if desired.

Font Bar

Color
Bar

Text
Tool

Toolbar

Text
Tool

Color
Bar

Tool

Tool
Selection
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• Use the drop-down lists on the Font Bar (Windows) or Toolbar (Macintosh) to 
choose the font and type size. You may also click on the B, I, or U to make the 
text bold, italic, or underlined.

3. When you are finished typing, click in the Chat Panel to return to your 
conversations or use any of RoundTable’s other meeting options.
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Sharing Files at the Meeting

Sometimes you need to share text at a meeting that is too much to type while others are 
waiting. Or, you may need to share highly formatted forms, spreadsheets, complex 
graphics—even audio and video clips. Some of these would be very time consuming to 
create on the meeting canvas; others —such as sound and video clips—would be 
impossible. But these sorts of information can be shared across the meeting canvas, either 
by importing them or by simply dragging and dropping the files onto the canvas. There is 
no limit to the type of files you can share at a meeting, although there may be a limitation 
to the size of the file. If necessary, check with your conference administrator about the 
maximum canvas size for your meeting.
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Dragging & Dropping FilesStep Procedure

1. If necessary, start the RoundTable client, connect to a conference, and then join the 
desired meeting.

2. Switch to your Windows File Manager or Explorer, or the Macintosh Finder, or 
otherwise locate the desired file (perhaps as a shortcut or alias on your desktop). 
Size and position the windows so that you can see both the desired file and the 
RoundTable meeting canvas.

3. Click on the file to select it. Hold the mouse button down while you drag the file 
onto the canvas; then release your mouse button.
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4. RoundTable copies the file onto the meeting canvas. Other meeting participants 
can drag the file off to copy it on their own desktops, or double-click the file to 
open and view it on their local machines.

Note that only one meeting participant can access a file at a time. When someone 
accesses a file (either to copy or to view), a broken box surrounds the file. No one 
else can access the file until that user releases it.

Also note that, because of differences in the ways that the Macintosh and Windows 
display the RoundTable meeting canvas, items placed near the bottom border by a 
Macintosh-based client may not be visible to Windows-based clients. 
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Importing Files Step Procedure

1. If necessary, start the RoundTable client, connect to a conference, and then join the 
desired meeting.

2. Click on the Meeting Canvas.

3. Go to the Canvas menu and select Import File. Navigate to locate the desired file. 
Click Open to import the file onto the canvas.

Note: The size of the files you can import is limited by the meeting’s canvas size. The 
default canvas size is 10 MB, but other sizes can be set by the RoundTable 
Conference Server administrator. If you need to share large files at a meeting, 
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contact the administrator about setting up a meeting with an unlimited canvas size.

4. RoundTable copies the file onto the meeting canvas. Other meeting participants 
can drag the file off to copy it on their own desktops, or double-click the file to 
open and view it on their local machines.

Note: Only one meeting participant can access a file at a time. When someone 
accesses a file (either to copy or to view), a broken box surrounds the file. No one 
else can access the file until that user releases it.
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Sharing URLs at the Meeting

In today’s computer culture, it’s only natural that meeting participants would want to share 
information about the Internet, including URLs. RoundTable makes it as easy to share 
URLs across the Internet as it is to share files from your desktop computer.

Before You Start You do not need a Web browser to share URLs in RoundTable. However, if you want to use 
your Web browser to find the desired URL or to view URLs from other meeting 
participants, you must have configured RoundTable to use your Web browser. Do this by 
going to RoundTable’s Options menu and selecting Preferences, then the General tab. In the 
text field marked Web Browser, type the complete path and filename of your Web browser 
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or use the adjacent Browse button to locate it. On Macintosh systems, you can also select 
the Use Internet Config option, in which case the Browse button will be grayed out and 
unavailable.

Sharing URLs through 
a Web Browser Step Procedure

1. If necessary, start the RoundTable client, connect to a conference, and then join the 
desired meeting.

2. Open your Web browser and navigate to the desired URL. For maximum ease of 
use, size and position the windows so that you can see both the desired URL and 
the RoundTable meeting canvas.

3. Choose any one of the following methods to import the currently viewed URL 
onto the RoundTable meeting canvas:

• Click the Grab URL icon on the Toolbar.

• Click on the canvas where you want to place the URL object, then go to the 
Canvas menu and select Grab URL.
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• Click on the Link icon in your Web browser and drag it onto the RoundTable 
canvas.

• (Windows only) Right-click where you want to place the URL object, then 
choose Grab URL from the shortcut menu that appears.

• In your Web browser, choose Copy this Link Location (in Netscape Navigator), 
Copy Shortcut (in Microsoft Internet Explorer) or other similar command. 
Switch to RoundTable, click on the canvas where you wish to place the URL, 
then go to the Edit menu and choose Paste. 

4. RoundTable copies the URL onto the meeting canvas. Other meeting participants 
can drag the file off to copy it on their own desktops, or double-click the file to 
open and view it on their local machines.
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Note that only one meeting participant can access a URL at a time. When someone 
accesses a URL (either to copy or to view), a broken box surrounds the file. No one 
else can access the URL until that user releases it.

Sharing a URL 
without a Web Browser Step Procedure

1. Click on the RoundTable Meeting Canvas in the approximate location where you 
want to place the URL.

2. From the Canvas menu, select New URL to display the New URL dialog.

3. Enter the Label and Location, then click OK.
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4. RoundTable places the URL on the meeting canvas. Other meeting participants can 
drag the file off to copy it on their own desktops, or double-click the file to open 
and view it on their local machines.

Note that only one meeting participant can access a URL at a time. When someone 
accesses a URL (either to copy or to view), a broken box surrounds the file. No one 
else can access the URL until that user releases it
RoundTable 2.0 User’s Manual 3–25



Attending RoundTable Meetings

Sharing Screen Captures

RoundTable recognizes that meetings may require the exchange of almost any sort of 
information. That’s why the program includes specific options for sharing chat text, URLs, 
sketches, and almost any kind of file. But what if you need to share information from a file 
that’s in a format the other meeting participants cannot read? For example, a graphic artist 
may want to share his rendering of the company’s annual report cover, but the other 
meeting participants are mainly accountants who do not have access to sophisticated 
graphics programs. Or some participants may be working under Windows, while others are 
on Macintosh machines. In these cases, you can use RoundTable’s image grabbing tool to 
share virtually any information that you can display on your own computer.
RoundTable 2.0 User’s Manual 3–26

Sharing Screen Captures Step Procedure

1. Open the appropriate program(s) and file(s), and arrange the desired information 
and images on your screen. If you do not have your General Preferences set to hide 
RoundTable when capturing images, you must arrange your screen so that you can 
see both the RoundTable program and the information you want to capture. (If 
you do have your General Preferences set to hide RoundTable when capturing 
images, RoundTable will automatically minimize itself when you grab an image.)

2. In RoundTable, click on the Grab Image tool OR go to the Canvas menu and choose 
Grab Image.

3. When your cursor turns into a crosshair, click and drag to define the area of the 
screen you want to capture. Give a second click when you have defined the area.

4. RoundTable captures screen image and places it on the meeting canvas. Other 
participants can view the image or drag it onto their own desktops to save it to their 
drives.
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Cleaning Up the Canvas

As the meeting continues and participants add files, URLs, screen captures, and drawings 
to the meeting canvas, it may become difficult to see things clearly. At any point, a meeting 
participant can rearrange the items on the canvas.

Arranging Canvas Objects Step Procedure

1. Adjust the meeting canvas to show all of the area you want to work with. 
• Use the split bar to adjust the relative size of canvas and chat windows. 
• Use the scroll bars to reposition the meeting canvas in its window.

Meeting
Canvas
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2. Use the Selection tool to select the item(s) you wish to move. 
• To choose adjacent items, hold down the mouse button and drag a rectangle 

around the items you want to select.
• To select multiple items from different parts of the canvas, hold down the Shift 

key and click on each item in turn.

3. To move the selected object(s), click and drag the object(s).

Aligning Objects 4. To line the selected objects evenly, go to the Canvas menu and choose Align Objects. 
From the fly-out menu choose Left, Right, Top, or Bottom to line the items up in the 
desired orientation. 

Chat
Window Split

Bar

Scroll
Bars
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Setting Up Private Meetings 

Anyone can create a private meeting at any time that they are connected to a RoundTable 
Conference Site. Private meetings do not require administrator privileges or a password.

Restrictions • Private meetings cannot be password protected or made read only. 
• Private meetings are “by invitation only”; that is, the user who creates the private 

meetings invites all desired participants. Other clients connected to the Conference Site 
cannot join the meeting; in fact, they will not even see it on their Meeting List. 

• A private meeting’s canvas size is limited to the maximum canvas size set for that 
Conference Site by its administrator.
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• Private meetings cannot be closed until all participants have left the meeting. Even if 
the meeting creator leaves the meeting, the meeting remains in session until the last 
participant has left.

• Private meetings are not persistent. When all meeting participants leave the meeting, 
RoundTable closes the meeting and deletes it from the Conference Site database.

Creating a 
Private Meeting Step Procedure

1. If necessary, start your RoundTable client and connect to the desired Conference 
Site. 

You can do this by going to the File menu and choosing Connect Conference; selecting 
your Conference Site from the Site drop-down box and typing the name you want 
to use in the Nickname text field; and clicking Connect.

2. Go to the Meeting menu and select New Private to display the New Private Meeting 
dialog.
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3. Type the name you want to give the meeting in the Title text field.

4. Use the Add and Remove buttons to select from the current conference Participants 
Invite OK
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those you want to  to your meeting. Click  to finish.

5. RoundTable creates the Meeting Canvas and sends invitations to the conference 
participants you chose to invite.

6. The meeting cannot be closed until all participants have left. Even if the meeting 
creator leaves the meeting, the meeting remains in session until the last participant 
has left.

7. When the last meeting participant leaves, RoundTable closes the meeting.
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Using Transcripts

One of the most important parts of attending a meeting is often keep track of what was 
decided! RoundTable makes this easy with its automatic transcripts.

Saving Transcripts Step Procedure

1. Start RoundTable, connect to a conference, and join a meeting. Use the Chat Panel 
and Meeting Canvas as desired.

2. To save objects on the Meeting Canvas, drag them to your local desktop.
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3. To save a transcript of all conversations conducted on the Chat Panel, go to the File 
menu and select Save Transcript or Save Transcript as.

4. Navigate the dialog box to the location where you wish to save the transcript and 
enter a name for it. Click OK to save the transcript in a basic text format.

5. If the conversation continues and you wish to save more of it, use the Save 
Transcript command to save all the text to the same file, or Save Transcript As to save 
it to a different filename or location.

Opening Transcripts 
Later

All transcripts are saved in a basic text format. You can use any word processor to open the 
files, even the Notepad or Wordpad that come on Windows machines, or the Macintosh 
Simple Text application.
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Going Home

Remember that each Conference Site can host more than one meeting, and that 
RoundTable can connect to a variety of Conference Sites. So: 

• If you leave one meeting, you are still connected to the Conference Site and can join 
another meeting. 

• If you disconnect from a Conference Site, you are still in the RoundTable program and 
can connect to another site.

• If you exit the RoundTable program, you will leave all meetings and disconnect from all 
Conference Sites

Leaving a Meeting Step Procedure
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1. To leave a meeting, go to the Meeting menu and select Leave.

2. RoundTable removes you from the Participant List for that meeting, but keeps you 
connected to the Conference Site. You may join a different meeting if you want. See 
Choosing and Joining a Meeting.

Related Pages:
Choosing and Joining a Meeting, pg. 3–9
Setting Up Your Personal Information, pg. 3–4

Disconnecting 
from a Conference Step Procedure

1. To disconnect, go to the File menu and select Disconnect Conference.

2. RoundTable disconnects you from the Conference Site but the client software keeps 
running. You may now connect to a different Conference Site if you want. See 
Setting Up Your Personal Information.

Exiting RoundTable Step Procedure

1. To leave all meetings, disconnect from all Conference Sites, and close the program, 
go to the File menu and choose Exit.

2. RoundTable removes you from the Participant List for any meetings, disconnects 
you from the Conference Site, and closes the program.
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4 RoundTable lets you customize and automate your meeting attendance in a variety of ways.

You can customize how RoundTable appears onscreen by displaying or hiding various 
screen elements and by setting color, font, and voice preferences.

This chapter also discusses ways you can automate your meeting presence. You can set up 
special text for quick comments; create standard action descriptions and special emoticons; 
and even save Conference Profiles that let you instantly connect to a conference.

Distinguishing Between 
Macintosh and 
Windows Instructions

This chapter contains the necessary information for running the RoundTable client 
software on both Windows and Macintosh machines. In most cases, the instructions are 
identical on both platforms. However, in some cases there are differences. To help you 
quickly locate the appropriate instructions for your system, we have used the following 
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visual clues:

Indicates information pertinent only to Windows systems.

Indicates information pertinent only to Macintosh systems.

If you see both graphics together or if there are no icons in that section, 
the information is substantially the same for both Windows and 
Macintosh systems.

The paper clip graphic calls your attention to a special note or tip that will make your 
RoundTable use easier or more productive.
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Customizing General Preferences

The RoundTable client program includes a number of preferences that allow you to 
customize the program. The General preferences govern how the program appears at 
startup as well as specifying file locations.

Web Browser RoundTable uses the specified Web browser when you tell it to grab the current URL and 
when you double-click a URL someone else has placed on the canvas.

Default Directory The Default Directory setting specifies the directory RoundTable uses to store temporary 
files. For example, if you double-click an iconized text object on the canvas, the file will be 
stored in this directory while you are editing the text
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Customizing Step Procedure 
General Preferences

1. Go to the Options menu and choose Preferences..., then select the General tab to 
display the General Preferences dialog.
RoundTable 2.0 User’s  Manual 4–3

2. To speed up loading of meeting canvases, disable the automatic loading of images 
by clearing the checkbox labeled Auto-Load Images (Macintosh) or Images 
(Windows). When you join a meeting, images will be represented only by small 
icons until you explicitly tell RoundTable to load the images. 

3. (Macintosh only) To keep from viewing comments made by the announcer, clear 
the checkbox labeled Hide Announcements.
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4. (Macintosh only) To use the Internet Config utility to set your Web browser and 
connection options, click to place an X in the checkbox labeled Use Internet Config.

5. To control the appearance of RoundTable when you first open the program, click 
or clear the items in the StartUp section. You may choose to hide or display the 
Conference Roster, Meeting List, and Welcome Screen.

6. To automatically minimize the RoundTable window when you use the Grab Image 
tool, mark the checkbox labeled Hide windows while grabbing image (Macintosh) or 
Hide while grabbing an image (Windows).

7. To specify the Web browser RoundTable should use, click the Browse button 
nearest the Web Browser label and navigate to your browser’s location. On a 
Windows system, you may type in the full path and filename. On Macintosh 
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systems, you can select the Use Internet Config option, (the Browse button will be 
grayed out and unavailable).

8. To specify the directory used for storing temporary items (such as canvas text files 
you are editing), click the Browse button nearest to the Default Directory label and 
navigate to the desired location. On a Windows system, you may also type the full 
path and filename into the text box. 

9. If you are finished making changes, click OK to close the dialog and save your 
changes.

If you do not want to save your changes, click Cancel to close the dialog and revert 
to the previous settings.

(Windows only) If you want to save your new preferences but not exit the dialog, 
click Apply.

If you want to change other preferences, click on the appropriate tab.
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Setting Font Preferences

The choice of font and size can significantly affect the legibility of your onscreen meetings. 
Given the wide variety of monitor resolutions, lighting conditions, and personal 
preferences, it is impossible to preset the ideal font for all situations. So RoundTable selects 
a default font, but gives you the option to set your own choices through the Fonts 
Preferences dialog.

Setting Font Preferences Step Procedure

1. Go to the Options menu and choose Preferences..., then select the Fonts tab to 
display the Fonts Preferences dialog.

\
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2. To set the style and size of text which is typed directly on the meeting canvas, use 
the drop-down list box labeled Canvas Text to choose your font and the adjacent 
Size text box (Macintosh) or drop-down list (Windows) to enter the desired size. 
On the Macintosh, you will see a sample of the font and size next to the Size text 
box.

3. To set the style and size of text which is entered in the chat window, use the 
drop-down list box labeled Chat Text to choose your font and the adjacent Size text 
box (Macintosh) or drop-down list (Windows) to enter the desired size. On the 
Macintosh, you will see a sample of the font and size next to the Size text box.

4. If you are finished making changes, click OK to close the dialog and save your 
changes.
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If you do not want to save your changes, click Cancel to close the dialog and revert 
to the previous settings.

(Windows only) If you want to save your new preferences but not exit the dialog, 
click Apply.

If you want to change other preferences, click on the appropriate tab.
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Setting Color and Voice Preferences

If you’re in a meeting with several participants, it may be difficult to keep track of who is 
saying what. RoundTable gives you the ability to assign different colors and voices to each 
participant to help you distinguish among their various comments.

Alternative Approaches Color and Voice preferences can be set both in the Preferences dialog and from the 
Participants menu. The Preferences dialog allows you to make choices for yourself, the 
announcer, and new participants entering the meeting. The Participants menu allows you 
to make choices for any participant by selecting their nickname either from the Conference 
Roster or from a meeting window’s Participant list.
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Setting Colors & Voices Step Procedure
in the Preferences Dialog

1. Go to the Options menu and choose Preferences..., then select the Colors tab to 
display the Colors Preferences dialog.
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2. Use the drop-down list of colors (Macintosh) or the Choose Color button 
(Windows) to select the color used to display chat text entered by yourself (Me), the 
Announcer, and any New Participant entering the meeting. If you select the Random 
check box, RoundTable assigns colors to new participants at random.
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3. If you are finished, click OK to close the dialog and save your changes.
Click Cancel to close the dialog and revert to the previous settings.
(Windows only) Click Apply to save changes without exiting the dialog.
To change Voice preferences, click the Voices tab to display the dialog box.
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4. Use the drop-down lists of voices to select the voice that will be used to present chat 
text entered by yourself (Me), the Announcer, and any New Participant entering the 
meeting. If you select the Random check box, RoundTable will assign voices to new 
participants at random.
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5. If you are finished, click OK to close the dialog and save your changes.
Click Cancel to close the dialog and revert to the previous settings.
(Windows only) Click Apply to save changes without exiting the dialog.
If you want to change any other preferences, click the desired tab to display the 
appropriate dialog box.

Setting Colors & Voices Step Procedure
on the Participants Menu

1. If necessary, go to the View menu and select Conference Roster to display the list of 
all conference participants. Then select the participant whose color or voice you 
want to set.

OR
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In a meeting, go to the Participants list and select the name of the participant whose 
color or voice you want to set.

2. To set the color of the participant’s chat text, go to the Participant menu and choose 
Color, then select the desired color from the flyout menu (Macintosh), or from the 
Color dialog (Windows). In Windows, you may also define a custom color, then 
click OK as necessary to exit the dialogs. On a Macintosh, you can also set the color 
from the Conference Roster window by selecting a participant’s nickname, then 
clicking the Color button at the top of the Conference Roster window to access the 
color choices.

3. To set the voice used to present the participant’s chat text, go to the Participant 
menu and choose Voice, then select the desired voice from the flyout menu (both 
platforms). If you choose None, that participant’s chat text will not be presented 
aloud.
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Changing RoundTable’s Appearance

RoundTable offers you a great deal of flexibility in setting up your meeting window. You 
can decide which screen elements you want to view and adjust the relative sizes of the 
Meeting Window’s canvas and chat panels.

Controlling Step Procedure
Screen Elements

1. Use the illustration below to determine the name of the screen element you want to 
view or hide.

2. Go to the View menu and select the desired screen element to toggle its display on 
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or off. Note: Elements with check marks will be displayed; those without checks will 
not be displayed.



Customizing & Automating RoundTable

3. Click and drag on the Split Bar to change the relative sizes of the meeting canvas 
and chat window. Note: Your cursor is in the correct location when it changes to a 
double-headed arrow split by one or two parallel lines.

Toolbar Font Bar

Draw Tools

Color Bar

Meeting List
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Status Bar
Draw Tools

Toolbar

Meeting List

Conference Roster

Conference Roster

Split Bar
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Using Standard Chat Text (Macintosh only)

If you find yourself giving certain explanations or using certain phrases repeatedly, you may 
want to set up standard chat text which you can add with a mouse click. RoundTable’s 
standard chat text works much like the Glossaries or AutoText entries in word processors: 
you enter it at length only once; thereafter, you can use a shortcut key or mouse clicks to 
enter the text quickly. It is useful for such things as a standard greeting, product 
descriptions, company information, or even your name and email address. 

Setting Up Chat Texts Step Procedure

1. Go to the Options menu and choose Setup Chats to display the Setup Chats dialog 
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box.

2. Click Add... to create new text.

OR

Select an existing chat entry from the scroll box and click Modify to change the text.
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3. In the dialog that appears, type your chat text in the Label text box. Click OK to close 
the dialog when you are done.

4. If you want to delete any standard chat texts, select the entry from the scroll box 
and click Delete.... 

5. If you want to edit any more standard chat texts, repeat the previous steps.

If you are finished editing standard chat texts, click Done to return to the main 
RoundTable program.

Using Standard Chats Step Procedure
in a Meeting
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1. If necessary, join a meeting and click to focus on the chat window.

2. If you want to send the standard chat text to all meeting participants, click on the 
Send button at the bottom of the chat window and select the desired text from the 
drop-down list.

OR

If you want to send the standard chat text to only a few meeting participants, select 
those participants from the Meeting’s Participants list, then click on the Whisper 
button at the bottom of the chat window and select the desired text from the 
drop-down list.

3. The selected standard chat text appears in the chat window.
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Setting Up Standard Actions (Macintosh only)

Sometimes you want to describe an action to add emphasis to your text in a meeting. If you 
find yourself using certain actions repeatedly, you may want to set up standard actions text 
which you can send with a mouse click. RoundTable sends actions by typing them in the 
chat window, preceded by two asterisks and the sender’s name.

Creating Step Procedure
Standard Actions

1. Go to the Options menu and choose Setup Actions to display the Setup Actions 
dialog box.
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2. Click Add... to create a new action.

OR

Select an existing entry from the scroll box and click Modify to change it.

3. In the dialog that appears, type your action description in the Label text box. Click 
OK to close the dialog when you are done.
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4. If you want to delete any standard actions, select the entry from the scroll box and 
click Delete.... 

5. If you want to edit any more standard actions, repeat the previous steps.

If you are finished editing standard actions, click Done to return to the main 
RoundTable program.

Using Standard Actions Step Procedure
in a Meeting

1. If necessary, join a meeting and click to focus on the chat window.

2. Click on the Actions button at the bottom of the chat window and select the desired 
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action from the drop-down list.

3. The action appears in the chat window, preceded by two asterisks and your name.
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Setting Up Emoticons(Macintosh only)

As electronic forms of communication have become more popular, a new way to show 
emotion has evolved. Called an emoticon or a smiley, it is a iconic representation of a facial 
expression created from standard punctuation symbols. Setting up an emoticon tells 
RoundTable what to say when another conference participant types the emoticon as chat 
text andyou have Voices turned on.

Creating Emoticons Step Procedure

1. Go to the Options menu and choose Setup Emoticons to display the Setup Emoticons 
dialog box.
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2. Click Add... to create a new action.

OR

Select an existing entry from the scroll box and click Modify to change it.
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3. In the dialog that appears, type your symbol in the Emoticon text box. In the Phrase 
text box, type the interpretation of the emoticon. RoundTable will use this phrase 
whenever you have voices turned on. Click OK to close the dialog when you are 
done.

4. If you want to delete any emoticons, select the entry from the scroll box and click 
Delete.... 

5. If you want to edit any more emoticons, repeat the previous steps.

If you are finished editing emoticons, click Done to return to the main RoundTable 
program.
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Using Emoticons Step Procedure
in a Meeting

1. If necessary, join a meeting and click to focus on the chat window.

2. Type in any chat you wish and add the punctuation symbols for the emoticon.

3. Meeting participants who have their Voices turned on will hear the corresponding 
descriptive text. 
Meeting participants who have their Voices turned off will see the emoticon in the 
chat window.
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Saving and Sharing Conference Profiles

RoundTable Conference Profiles give you a simple but powerful way to save and share all 
the information you need to join a conference and a meeting. A Conference Profile 
contains information that describes a conference, including the server IP address, port 
number, meetings you have joined, and the colors and voices you have assigned to the other 
participants. You can use a Conference Profile to rejoin a meeting later, or you can send the 
Conference Profile (*.RTC file) to someone else so that they can easily join the same 
meeting. You could even put a link to a Conference Profile on a Web page to provide quick 
access to your conferences and meetings.

Security Precautions As a security precaution, RoundTable Conference Profiles do not save your password if you 
are accessing an authenticated server or accessing a meeting as an administrator. 
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Creating a 
Conference Profile Step Procedure

1. Start the RoundTable client, connect to a conference, and, if desired, join a 
meeting. Set up any colors, voices, or other special options you wish.

2. Go to the File menu and select Save Conference Profile or Save Conference Profile as 
to open the Save or Save as dialog.

3. Navigate to the location where you want to store your Conference Profile and give 
it a name. 

• If you wish to save your nickname as part of the profile, put an X in the Include 
Nickname (Windows) or Save Nickname (Macintosh) check box.

• (Macintosh only) Put an X in the Save Joined Meetings check box if you wish to 
automatically rejoin the current meetings. (The Windows clients automatically 
saves your currently joined meetings.)

4. Click Save to save the Conference Profile.

Sharing Conference 
Profiles

Conference Profiles can be shared like any other file. Just copy the appropriate *.RTC file to 
a disk or other transportation mechanism, or place a link to the *.RTC file on a Web page.



Glossary

address Either an IP Address (the 32-bit address assigned to TCP/IP host computers) or an e-mail 
address (the name and location address to which all of your electronic mail is sent).

authenticating server Server which requires that a previously set up username or password be entered before a 
user is allowed access.

broadcast meeting also called a one-way meeting. RoundTable meeting with a read-only canvas so that only the 
server administrator can set up and make changes to the canvas. Users can view or copy 
canvas items, but cannot make any changes or deletions.
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browser (Web browser) Program that allows the user to find and view information on the World Wide Web 
(WWW). It generally refers to a Web browser, which translates HTML-coded pages into 
graphical interfaces on the user’s computer.

client Within the context of RoundTable, the software that gives users access to meetings, but does 
not allow them to interfere with the operation of the conference server.

conference profile Small file with an extension of .RTC which contains all the information needed to connect 
to a RoundTable conference site and meeting. Conference profiles can be used as desktop 
shortcuts for immediate meeting access; they can also be shared via e-mail or any type of 
file transfer so that multiple users can quickly access the same meeting.

conference server Computer running the RoundTable server software with which the conference 
administrator sets up various meetings, allowing people from all over the world to chat and 
share information.

conference site Location of the computer running the RoundTable server software. Identified by an IP 
address or URL.



console application Computer program (in this case, usually the RoundTable server software) run from a DOS 
instance. 

dial-up Commonly used method of accessing the Internet. A dial-up connection uses regular 
phone lines to connect one computer to another through a modem. Windows 95 includes 
facilities for implementing Dial-up Networking through a special icon in the Accessories 
folder.

DNS (Domain Name System). Database system used to map the meaningful names humans use 
to refer to machines on the Internet (such as, The ForeFront Group) onto the IP addresses 
that the computers use to access one another. DNS allows the user to type in a simple, 
memorable company name which the computer converts into a unique series of numbers. 
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domain Technically, the alphanumeric part of the DNS naming system; it is usually identifiable as 
a series of words separated by periods (called dots). For example, ffg.com is pronounced 
ffg-dot-com. In general terms, a domain is a logical region of the Internet and is commonly 
referred to as a site.

DOS instance also known as DOS window. Window to the command prompt or DOS system opened 
from within Windows. Gives access to a traditional C-prompt interface.

e-mail (electronic mail) Method by which computer users can exchange messages over a network. 
E-mail is probably the most widely used communications tool on the Internet. There are 
many conventions to e-mail, but most entail “To:”, “From:”, and “Subject:” lines. One of 
e-mails advantages is its ability to be forwarded and replied to easily. 

e-mail address Set of names which routes your e-mail to you. By convention, an e-mail address is made up 
of several parts, separated by periods. The first part of the address, the username, identifies 
a unique user on a server. The “@” (pronounced “at” in the United States) separates the 
username from the host name. The host name uniquely identifies the server computer and 
is the last part of the Internet e-mail address. Large servers, such as those used at 
universities or large companies sometimes contain multiple parts, called subdomains. 
Subdomains and the host name are separated by a “.” (pronounced “dot”). 



The three-letter suffix in the host name identifies the kind of organization operating the 
server (some locations use a two-letter geographical suffix). The most common suffixes are: 
com (commercial), edu (educational), gov (government), mil (military), net (networking), 
org (non-commercial). Addresses outside of the U.S. sometimes use a two-letter suffix that 
identifies the country in which the server is located. Some examples are: jp (Japan), nl (The 
Netherlands), uk (United Kingdom), ca (Canada), tw (Taiwan).

emoticon Iconic representation of facial expression or emotion created from standard punctuation 
marks. Also known as a smiley.

firewall Network node used as a boundary, or security device, to prevent Internet traffic from 
crossing over from one side to another. A firewall may be implemented in a router 
protecting a company’s or institution’s server, or it may be a specialized device used for such 
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purposes.

FTP (File Transfer Protocol) TCP/IP protocol for transferring (copying) from one machine on 
the Internet to another. Basically, it is the Internet version of the File Copy functions on 
most desktop platforms. Since FTP evolved on the UNIX platform, its commands for 
making and changing directories, transferring, copying, moving, and deleting files were 
originally rather arcane text-based commands typed at a prompt. Fortunately, many 
graphical applications are now available that make FTP commands as easy as dragging and 
dropping. 

gateway Within the context of RoundTable, a program which tracks the meetings currently in 
session on a RoundTable server and presents access to the conference and those meetings 
in the form of a Web page with clickable links to the meetings.

gopher Information search and retrieval tool used widely for research. Gopher information is 
stored hierarchically on computers across the Internet. It uses a simple protocol that allows 
a client to access information from a multitude of numerous Gopher servers at one time, 
creating what’s known as gopher space. The most common search tools in gopher are 
Veronica and Jughead. Gopher clients exist for most platforms. 



group meeting Public, persistent RoundTable meeting open to anyone with the RoundTable software. 
Group meetings may also be protected with a password.

home page Point of entry into a company’s, individual’s, or institution’s set of HTML pages on the 
World Wide Web. This foundation page is often used as an index with links to other 
resources on the Web or to other Internet servers.

HTML (HyperText Markup Language) Standard way to mark text documents to be published on 
the World Wide Web. HTML code is distinguished by its use of tags surrounded by 
brackets; for example, <BODY> is the standard tag for beginning the body of any HTML 
document. HTML code is what you see when you select View Document Source in your 
browser. 
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IP IP stands for Internet Protocol, the second half of the standard TCP/IP package that 
provides the most fundamental protocols on the Internet. IP defines the unit of 
information passed across the Internet.

IP address 32-bit address assigned to Internet hosts using TCP/IP. 

ISDN (Integrated Services Digital Network) Access provided by telephone carriers which combines 
voice and digital (computer) services on a single medium. ISDN connections provide faster 
access than is available through basic modem connections.

mirror site Many Web and FTP sites have become so popular that they have acquired “mirror sites” to 
alleviate congestion. Mirror sites are areas on another computer that “mirror” or contain 
an exact replica of the directory structure of the files on the overly popular site’s computer. 
If you have trouble getting connected to an FTP site, for example, because of the high 
amount of traffic, you can usually connect to a mirror site that contains the same 
information on a different computer. Mirror sites are usually updated once a day.

NNTP (Network News Transport Protocol) Industry standard protocol for the distribution, inquiry, 
retrieval, and posting of news articles.



one-way meeting also called a broadcast meeting. RoundTable meeting with a read-only canvas so that only 
the server administrator can set up and make changes to the canvas. Users can view or copy 
canvas items, but cannot make any changes or deletions.

persistent meeting RoundTable meeting which remains on the conference server even when no one has joined 
the meeting. Also known as a permanent meeting, in contrast to a transient meeting. 

PPP (point-to-point protocol) Protocol that provides a method for transmitting packets over 
serial point-to-point links. PPP is one of the most popular methods for dial-up 
connections to the Internet, since it allows you to use other standard protocols (such as 
IPX, TCP/IP, and Netbeui) over a standard telephone connection, but it can also be used 
for LAN connections.
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private meeting Transient RoundTable meeting created “on-the-fly” and open only to the meeting creator 
and those who are specifically invited to the meeting. Private meetings do not even appear 
on the Conference Roster of non-invited conference attendees. 

profile see conference profile

protocol Language spoken between computers to exchange information. More technically, a 
protocol is the formal description of formats and rules followed by machines to exchange 
information. Different protocols are used to exchange different sorts of messages, such as 
news for newsgroups and FTP for file transfers.

proxy server Application which passes information between a browser and the Internet. 

public meeting Persistent RoundTable meeting open to everyone with RoundTable software. Public 
meetings may also be protected with a password.

read-only canvas RoundTable meeting screen which contains information that users can view and copy but 
not move, delete, or otherwise change. Read-only canvases are useful for distributing 
information in an attractive, easy-to-use format while protecting it from unauthorized 
changes or deletions.



RTC file File ending with the extension RTC that contains a conference profile.

server In RoundTable, software that runs on Windows NT or 95 machine and creates the 
RoundTable conference site. From the server, the conference administrator controls 
permanent meetings, canvas size, maximum number of users, etc. 

SLIP (Serial Line Internet Protocol) Standard protocol (similar to PPP) which is used to run 
TCP/IP over serial lines, such as telephone circuits or RS-232 cables. Unlike PPP, however, 
SLIP does not work on a LAN connections. SLIP is probably the most popular way for 
dial-up users to access the Internet. In general, Web access requires a SLIP or PPP 
connection.

T1/T3 Two terms coined by AT&T to describe the types of high-speed connections of hosts to the 
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Internet. A T1connection transmits a DS-1 formatted digital signal at 1.544 megabits per 
second. A T3 connection transmits a DS-3 formatted digital signal at 44.746 megabits per 
second.

TCP (Transmission Control Protocol) First half of standard TCP/IP package that provides the 
most fundamental Internet protocols. TCP supplies transport level standards that allow a 
process on one machine to send data to a process on another machine.

TCP/IP Standard package that provide the most fundamental protocols on the Internet. 

transaction log RoundTable server-based file which tracks conference transactions. The level of detail 
ranges from 1 (configuration parameters, version number, time-started, log-ins and 
log-outs, and errors only) to 5 (which logs every transaction).

transcript File that saves a copy of all the chat text from a meeting.

transient meeting RoundTable meeting which closes when the last meeting participant leaves. Typically 
applies only to private meetings.



URL (Uniform Resource Locator) Standard address format used to identify and locate Internet 
sites. World Wide Web site URLs begin with the prefix http:// (HyperText Transfer 
Protocol), generally followed by www (World Wide Web). After the standard prefixes, 
URLs use identifiers for different domains and subsections of domains, each separated by 
a period (.). The various levels of a site are separated by a forward slash (/); individual home 
pages are often preceded by a tilde (~).

Web page Page of a document on the World Wide Web.

WWW (World Wide Web or Web) Collection of on-line documents housed on Internet servers 
around the world. The concept of the Web was created by researchers at CERN in 
Switzerland. Web documents are written or coded in HTML. To access these documents, 
you must use a Web browser, such as Internet Explorer or Netscape Navigator. When these 
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browsers access (or hit) a page, the server uses the HyperText Transfer Protocol (HTTP) to 
send the document to your computer.
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